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1 Introduction 

Nascap-2k is a spacecraft charging and plasma interactions code designed to be used by 

spacecraft designers, aerospace and materials engineers, and space plasma environments experts 

to study the effects of both the natural and spacecraft-generated plasma environments on space 

systems. This document consists of examples constructed to illustrate the use of Nascap-2k to 

analyze moderately complex interactions between spacecraft surfaces and the plasma 

environment. These examples augment those included in the Nascap-2k User’s Manual 

distributed with the code. The narrative below assumes familiarity with the use of Nascap-2k and 

the field of spacecraft-environment interactions. Specific results may be slightly different from 

those given here due to small differences in the geometry, material selection, and version of 

Nascap-2k. 

The object, project, and grid files are included in the Manuals folder, along with the 

documentation.  

2 Charge Plate Analyzer 

A simple Surface Charging Detector has been proposed1 and flown2. A simplified circuit for this 

device is shown in Figure 1. The upper part of this circuit represents the resistance and 

capacitance of a dielectric surface to its underlying conductor, which is an isolated metal plate. 

The lower part of the circuit represents a physical capacitor and physical resistor that couple the 

plate to spacecraft ground. The instrument measures the potential difference between the plate 

and spacecraft ground. 

In this example, Nascap-2k is used to study the response of a simplified version of the Charge 

Plate Analyzer (CPA) to rapid changes in the environment. The capacitive and resistive coupling 

between conductive elements are used to explicitly model the components in the lower part of 

Figure 1. The upper part of Figure 1 is modeled by setting the thickness, dielectric constant, and 

bulk conductivity of the surface material.  

 

Figure 1. Simplified circuit for the Charge Plate Analyzer. The upper portion of the figure 

represents the properties of a dielectric coating, while the lower portion of the figure shows the 

measurement circuit. 
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2.1 Create model of spacecraft with CPA 

The spacecraft for this example is a conductive box with a patch on the side to represent the 

instrument. 

2.1.1 Create spacecraft body 

Open Object Toolkit. Create a Box that is zoned 7 × 7 × 7, has dimension 1.4 m × 1.4 m × 1.4 

m and has all surfaces graphite and conductor 1. 

2.1.2 Define the CPA1 material 

The CPA has an area of 25 cm2 and a dielectric thickness of 0.002 inches (5×10-5 m). Click the 

Material menu and select “New…”. Initially the Material Definition dialog box shows default 

Kapton properties. Set the material thickness to be 5×10-5 m. To obtain the capacitance and 

resistance shown in the circuit, use a dielectric constant of 1.129 and bulk conductivity of 

5×10-14 ohms-1 m-1. Set the surface resistivity to be of 7×1011 ohms/square. For the purposes of 

this example, leave the remaining properties as those of default Kapton. Finally, select a 

distinctive color to represent the material, and click “OK”.  

2.1.3 Subdivide to form CPA surface elements 

The process of subdividing the central element to form the CPA instrument is shown in Figure 2. 

1. Select the element at the center of the +Z face of the cube. Subdivide the element. Then 

subdivide each of the four subelements. The original element is now replaced by 16 

subelements, each of which is 5 cm square. 

2. Delete the 12 subelements around the periphery of the original element, leaving the four 

subelements in the center. 

3. Define four parallelogram elements to mesh compatibly with the 20 cm elements that 

make up the bulk of the face. For each of these new elements you will need to select the 

four nodes of the element in counterclockwise order, and click the “Create Element” 

menu tem of the Mesh menu. 

4. Subdivide the four central elements and delete the twelve elements around their 

periphery, similar to step 2 above. 

5. To maintain the 2.5 cm resolution on the CPA, use alternate parallelogram and triangle 

elements to connect the CPA to the outer parallelogram elements. 

6. Correct the materials. The added elements default to Kapton, and must be converted to 

Graphite. Set the central four elements to be the CPA1 material and set their underlying 

conductor number to be 2. If the spacecraft had multiple CPAs, each would be assigned a 

different conductor number. 

7. Save the object and exit Object Toolkit. 
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(a)  (b)  (c)  (d)   

(e)  (f)  (g)  (h)   

(i)  (j)  
 

Figure 2. Steps to define the CPA instrument on the face of the spacecraft. 

(a) delete element; (b,c) divide elements; (d) delete elements; (e,f) create elements; (g) divide 

and delete elements; (h) create elements; (i) assign materials; (j) assign conductors. 

2.2 Initialize project 

Open Nascap-2k and import this object into a new Nascap-2k project.  

On the Problem tab, specify the problem as “Geosynchronous” “Surface Charging” with 

“Analytic Currents”. 

On the Environment tab, select the “Worst Case” environment and set the “Relative Sun 

Intensity” to 0.0 (eclipse condition). 

On the Applied Potentials tab. Set conductor 1 (Spacecraft Ground) to be floating at an initial 

potential of 0 V. Set conductor 2 (CPA underlying conductor) to be floating at an initial potential 

of 0 V. To match the circuit components of Figure 1, set capacitive coupling of 5×10-8 farads 

between the two conductors, and set resistive coupling of 109 ohms between the two conductors. 



 

4 

 

Figure 3. Environment tab values for the CPA example. 

 

Figure 4. Applied Potentials tab values for the CPA example. 

On the Charging tab, use the default of charging for 300 seconds with 45 timesteps in the range 

of 0.1 to 60 seconds. 
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On the Script tab, build the script. Expand the Charge Surfaces command, and then the 

“SetCircuit” second level command to observe that the capacitance and conductance correspond 

to the values entered on the Applied Potentials tab. Click the “Run Script” button to execute the 

script. 

 

Figure 5. Charging Tab for CPA example. 

 

Figure 6. Script tab for CPA example. 
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2.3 Examine results in eclipse condition 

On the Results tab, define two “Surface Element Groups” corresponding to conductors 1 and 2. 

Select both groups, as well as both conductors in the “Conductors” panel. Select “Potential”. 

Note that the entire spacecraft has charged to -27 kV.  

Select “Differential Potential”. On the Graph subtab click “Plot”, and note that the CPA surface 

has charged to a positive differential of about 70 V. The Text subtab shows that the CPA has a 

differential potential of 69.89 V (relative to its underlying conductor 2), but, as shown in the left 

panel, a differential potential relative to chassis of 70.11 V. The difference of 0.22 V is the 

measured potential of conductor 2 relative to chassis, and, as a 400:1 resistive divider, predicts a 

differential potential of 88 V on the CPA surface, which is reasonable as the CPA is continuing 

to differentially charge at about 0.1 volts per second. 

Select “Charging Current”. On the Graph subtab click “Plot”. On the Text subtab note that the 

CPA surface is subject to charging current of 9.3×10-8 Am-2. Accounting for the CPA area of 

25 cm2, this predicts a voltage of 0.23 V across the 109 ohm CPA resistor, and a steady-state 

differential potential of 92 V on the CPA surface. 

Note that the shorter RC time constant of the CPA measurement circuit makes it a good predictor 

of the eventual CPA differential potential for this case. 

2.4 Examine results in sunlit condition 

On the Environment tab, set the “Direction to Sun” to be (0, 0, 1) and the “Relative Sun 

Intensity” to be 1.0, so that the face of the spacecraft containing the CPA is sunlit.  

On the Charging tab, reduce the duration of the calculation to 120 seconds with no change in the 

other parameters. 

On the Script tab, go to the Edit Script subtab. In order to continue the previous calculation 

with the new parameters, delete the Read Object command and expand the Charge Surfaces 

command and delete the “SetInitialConductorPotentials” second level command. Confirm that 

the attributes of the “SetIllumination” second level command reflect the values entered on the 

Environment tab. Click the “Run Script” button to execute the script. 

On the Results tab, select “Potential” and click “Plot”. Note that the spacecraft potential rises 

from -27 kV to about -6 kV due to the sudden onset of sunlight.  

Select “Differential Potential” and click “Plot”. Note that the differential potential on the CPA 

has dropped rapidly to about 40 V. On the Text subtab, note that the CPA surface differential is 

oscillating with amplitude of about 0.5 V. This makes it difficult to infer the CPA measurement 

voltage, which should be about 0.1 V. Note that the “Charging Current” to the CPA is also 

oscillating as the photoelectron suppression is turned on and off by the small changes in surface 

potential. 

2.5 Examine results in shadowed condition 

On the Environment tab, set “Direction to Sun” to be (0, 0, -1) and the “Relative Sun Intensity” 

to 1.0, so that the face of the spacecraft opposite the CPA is sunlit.  

On the Charging tab, restore the duration of the calculation to 300 seconds. 
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On the Script tab, no further changes should be required. Check that the parameters are correct. 

Click the “Run Script” button to execute the script. 

On the Results tab, select “Potential” and click “Plot”. Note that the spacecraft potential remains 

at about -6 kV, but the CPA is differentially charging negative. 

Select “Differential Potential” and click “Plot”. The Text subtab shows that the CPA surface is at 

-630.4 V relative to its underlying conductor. Since the CPA surface is the minimum potential in 

the problem, and the chassis potential is the maximum potential, the table in the left panel shows 

that the CPA is at -632.5 V relative to chassis. This means the CPA must be measuring -2.1 V, 

suggesting a steady-state CPA surface differential of -840 V. 

2.6 Examine CPA measured potentials 

At this writing the Nascap-2k interface does not provide enough digits in the potential history 

display to accurately determine the measured potential difference between the CPA backplate 

(conductor 2) and spacecraft ground (conductor 1). However, this information can be obtained 

from the .log file, which contains lines such as 

cond. 0  isBiased=0  bias=0.000000  potl=-1851.127063 

cond. 1  isBiased=0  bias=0.000000  potl=-1851.134644 

Use a search utility to extract those lines and import them to a spreadsheet. Subtract the potential 

values to obtain the time history of the CPA measurement. Plot this along with the CPA surface 

differential potential. The result is shown in Figure 7. The differential potential on the CPA 

material is plotted against the left-hand axis and the difference between the two conductors is 

plotted against the right-hand axis. 

 

Figure 7. Time history of CPA surface differential potential (left axis) and measurement potential 

(right axis) for the eclipse, sunlit, and shadowed portions of the calculation. 
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2.6.1 Eclipse period 

It takes about four seconds (14 timesteps) for the entire spacecraft to charge to its steady-state 

potential of -26 kV. For the remainder of the eclipse period, the charging current to the CPA is 

fairly constant.  

For the next few seconds the ratio between the CPA surface differential and the CPA 

measurement voltage is about 100:1, as determined by the ratio of capacitances. For example, at 

6.17 seconds the surface differential is 11.79 V while the CPA measurement is 0.1144 V. 

During the remainder of the period, the CPA measurement remains fairly constant while the 

surface differential continues to rise, as the circuit transitions from a 100:1 capacitive divider to a 

400:1 resistive divider. At the end of the eclipse period (300 s) the surface differential is 69.89 V 

and the CPA measurement is 0.2196 V, a ratio of 318:1. 

2.6.2 Sunlit period 

The sudden onset of sunlight causes a sharp transient as the spacecraft potential rises to -6 kV. 

The CPA surface differential first rises and then drops to 40 V, the potential at which 

photoelectron emission is marginally limited by an electric field barrier. This net drop of 30 V 

corresponds to a 0.3 V drop (governed by the 100:1 capacitive divider) in the CPA measurement 

voltage. At this point the CPA measurement voltage of -0.06 V is giving a completely erroneous 

indication of the actual 40 V surface differential. 

During the remainder of the sunlit period, the CPA measurement potential rises toward a correct 

indication of the 40 V surface differential. At the end of the sunlit period (420 s) the surface 

differential is 39.18 V and the CPA measurement is 0.0764 V, a ratio of 513:1. 

2.6.3 Shadowed period 

During the shadowed period, the charging current to the CPA surface again varies slowly with 

potential. The CPA measurement initially drops at 1/100 the rate of drop in surface differential. 

Eventually the CPA measurement saturates at -2.06 V (predicting a surface differential of  

-824 V) while the surface differential continues to drop. At the end of the shadowed period 

(720 s) the surface differential is -630.4 V (and dropping) and the CPA measurement is  

-0.2065 V, giving a ratio of 305:1 (and rising). 

2.6.4 Discussion 

After a transient change in conditions, the CPA measurement changes at 1/100 the rate of change 

of the surface potential, as dictated by the capacitors in the circuit—that is, the instrument 

behaves as a capacitive divider. It takes a minute or more for the ratio of the two potentials to 

approach 400:1, as dictated by the resistors in the circuit. During the intervening time the 

measurement can be quite misleading, especially if there is a change in sign of either potential. 

In Figure 8, after each transient change, the ratio of the time derivatives (slope ratio) of the 

surface potential and CPA measurement voltage takes the value of 100 (capacitance ratio) and 

rapidly rises or shifts to erratic behavior. The ratio of the values of those quantities may behave 

erratically following the transient change, but eventually drifts toward a steady-state value of 400 

(resistance ratio).  
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Figure 8. Time dependence of the ratio of the surface differential to the CPA measurement 

voltage, and the ratio of the time derivatives of those quantities. 

Specifically considering the sunlit period (Figure 9), from 300 to 306 seconds, the ratio of the 

slopes is near 100 (capacitive divider) as the differential potential rapidly drops from ~70 V to 

~40 V (Figure 7) and the CPA measurement drops from 0.35 V to -0.05 V. From 306 to 318 

seconds, the slope of the CPA measurement is near zero while the differential potential varies 

within a narrow range to seek the right potential for efield limiting. The ratio of the slopes is not 

a useful measure during this period. Finally, from 318 to 420 seconds the differential potential is 

nearly constant (so the ratio of the slopes is near zero) as the CPA measurement rises through 

zero to approach a 400:1 resistive divider value ratio from above. Thus depending on the system 

history, the 400:1 ratio may be approached from above or below. 
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Figure 9. Time dependence during the sunlit period of the CPA measurement voltage (left axis), 

and the ratio of the time derivative of the surface differential potential to the time derivative of 

the CPA measurement (right axis). 

3 Tether Voltage 

The following example illustrates the use of resistive coupling to explore the effects of resistance 

on a simple tethered system model. To make this example as simple as possible, orbit-limited 

current collection models that do not adequately represent the actual current collection in a dense 

low-Earth-orbit plasma environment are used. The simplifications are discussed at the end of this 

description. 

In the coordinate system used,  points East, points down, and  points South. The spacecraft 

velocity is taken to be eastward (positive ), and the magnetic field northward (negative ). 

Imagining a spacecraft to be a perfect conductor, the force on an electron in that conductor must 

be zero (or else infinite current will flow). Viewing the spacecraft from the external plasma, the 

downward magnetic induction force must be balanced by an upward electric force, so the top of 

the spacecraft is at positive potential relative to the bottom. Charge conservation requires that 

electrons collected at the positive (top) end be balanced by ions collected at the negative 

(bottom) end, so that current flows upward (electrons flow downward) through the spacecraft. 

The top-to-bottom potential difference cannot be measured by conventional meters and probes, 

as the probe leads are subject to the same magnetic induction force as the spacecraft itself. The 

potential difference can be measured using Langmuir probes (which measure the difference 

between local spacecraft ground and local plasma potential) at the top and bottom of the 

spacecraft. The potential difference can also be inferred by interrupting the current flow with a 

resistor. 
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3.1 Object definition 

The spacecraft for this example is constructed of three components: an upper body, a tether stub, 

and a lower body. The upper body is 200 m above the lower body. The tether connecting the two 

is taken to influence the potentials only by its resistance and is therefore represented only by the 

tether stub in the geometry. 

3.1.1 Create upper body 

Create a Box that is zoned 3 × 3 × 3, has dimension 1 m × 1 m × 1 m, and has all surfaces 

aluminum and conductor 1. Select the component and, using the “Place” menu item on the 

Component menu, move the box to a temporary location at Z = -5 m. 

3.1.2 Create tether stub 

Create a Boom that is zoned 1 × 1 × 2 and has dimension 0.1 m × 0.1 m × 1m. Make the surfaces 

Graphite and conductor 2. Select a node on the +Z end of the boom and using the “Node Relative 

Move” menu item on the Component menu move it to a position of Z = -1.1 m and centered in 

X and Y. 

3.1.3 Create lower body 

Create a Cylinder with 12 circumferential zones, 8 zones along its height, a height of 8 meters, 

and a diameter of 2 meters. Make the surfaces Gold and conductor 3. Select an edge parallel to 

the cylinder axis and, using the “Align Edge” menu item on the Component menu make that 

edge parallel to the Y axis. Viewing the cylinder from the –X direction, select the node at the 

center of the cylinder and move it to position (-1, 0, 0). 

3.1.4 Move upper body 

At this point the object should appear as shown in Figure 10 (with y-axis pointing right and z-

axis pointing down). Select the upper body and use the “Place” menu item on the Component 

menu to move the upper body from Z = -5 m to Z = -200 m. Zoom out to assure the operation 

has been done correctly. Save the object. 
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Figure 10. View of tether example object prior to moving upper body to -200 m.  

(View from –X direction with Z downward.) 

3.2 Initialize project 

Import this object into a new Nascap-2k project.  

1. On the Problem tab, specify the problem as “LEO or Plume” “Surface Charging” with 

“Analytic Currents”. 

2. On the Environment tab (Figure 11), set the electron and ion densities to be 109 m-3 and 

the electron and ion temperatures to be 1 eV. Specify a northward magnetic field of By = 

-3×10-5 T. Specify eastward spacecraft velocity Vx = 7500 ms-1. Specify zero sun 

intensity, and define the Oxygen ion species. This environment is selected to produce 

plasma-induced potentials small compared with the magnetically induced potential while 

having enough current to be influenced by reasonable resistive terms to be introduced 

below. 

3. On the Applied Potentials tab (Figure 12) 

a. Set conductor 1 (Upper Body) to be floating at an initial potential of 0 V. 

b. Set conductor 2 (Tether Stub) to be biased relative to conductor 1 at potential 

difference of 0.0 V. This bias plays the role of the physical tether (which need not 

be defined), with the logical connection taking the place of a physical connection. 

c. Set conductor 3 (Lower Body) to biased relative to conductor 1 at potential 

difference of 0.0 V. This sets the entire system to be effectively a single 

conductor. 
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Figure 11. Environment tab values for the Tether example. 

 

Figure 12. Applied Potential tab for Tether example. 

4. On the Charging tab, specify charging for 3 seconds using 10 timesteps with a minimum 

of 0.1 seconds and a maximum of 1.0 seconds. 

5. On the Script tab, build the default script. The script should now appear as shown in 

Figure 13. Note the presence of the “SetBField” and “SetVelocity” second level 

commands, and the initialization of v × B potentials (“Set VXBPotentials”) prior to the 
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“DoTimeSteps” second level command. Click the “Run Script” button to execute the 

script. 

 

Figure 13. Script tab for Tether example. 

3.3 Examine results with all components connected 

On the Results tab, select “Potential”. To see the v × B potentials it is necessary to look at the 

surfaces rather than the conductors, which are not localized. In the top panel, add two additional 

“Surface Element Groups” for a total of three. In the “Conductor” column specify the conductors 

1, 2, and 3. Check all three “Plot” checkboxes and click the “Plot” button.  

On the Text subtab, note that the upper body reaches steady state at an average potential of 

6.9 V, the tether stub at -37.8 V, and the lower body at -38.2 V. Next plot the “Charging 

Current”. The average current to the upper body is -210 μA m-2, while the average current to the 

lower body is +22.4 μA m-2. Accounting for the surface areas of 6 m2 for the upper body and 

55.7 m2 for the lower body gives that the upper, electron-collecting body collects -1.26 mA, 

while the lower, ion-collecting body collects 1.25 mA, with ions collected by the tether stub 

making up the difference. 

3.4 Examine results with lower body floating. 

On the Applied Potentials tab, change the lower body (conductor 3) from biased to floating. 

Return to the Script tab. The script has been automatically updated to reflect the change. Click 

the “Run Script” button to execute the script. 

On the Results tab, select “Potential” and plot the three surface element groups. On the Text 

subtab, note that the upper body reaches steady state at an average potential of -1.96 V, the tether 

stub at -46.6 V, and the lower body at -2.53 V. Next plot the “Charging Current”. The lower 
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body averages near zero charging current, while the upper body is slightly more positive, with its 

net electron current balanced by ions collected by the tether stub. 

3.5 Examine results with lower body resistively coupled 

Return to the Applied Potentials tab. Click the “Add Resistance” button to add a row in the 

“Applied Resistance and Capacitance” table. Set the resistance between the lower body and 

tether stub (conductors 3 and 2) to be 30 kΩ (3×104 ohms).  

Return to the Script tab and expand the “SetCircuit” second level command to note that it 

contains a conductance that is the reciprocal of the resistance entered above. Click the “Run 

Script” button to execute the script. 

On the Results tab, note that the three components reach steady state potentials of 3.4 V, -41 V, 

and -21 V, each component approximately midway between the previous two cases. 

Repeat the calculation with resistance values of 1000 Ω, 10 kΩ, 100 kΩ, and 1 MΩ. The results 

for the upper body, the lower body, and the measurable difference V2-V3 (the tether stub 

potential as measured from the lower body) are shown in Figure 14. 

 

Figure 14. Potential of upper body (V1, upper curve), lower body (V3, upward sloping curve) 

and the measurable difference (V2-V3) as a function of tether root coupling resistance. Note that 

the end points (100 Ω, 10 MΩ) are actually the shorted (Section 3.3) and floating (Section 3.4) 

cases respectively. 

3.6 Discussion 

When resistance is included in a simple tether model, the upper body has maximum potential 

when grounded (or coupled by low resistance) to the lower body, and minimum potential when 

decoupled (or coupled by high resistance) from the lower body.  
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The above simulation uses orbit-limited currents (maximum currents) to each body, ignoring the 

effects of sheath and magnetic field limiting. To do this correctly in Nascap-2k, a computational 

grid is constructed about the upper and lower bodies and the sheath currents computed. In the 

above, at the maximum potential of 6.9 V, the upper body collects 1.3 mA of electrons. In fact, 

the magnetically limited current3 at this potential is only about 0.2 mA. This means the upper 

body can rise to considerably higher potential so that its electron current increases to match the 

lower body ram ion current. 

To perform this calculation with tracked currents, see Section 4, “Tether Voltage with Tracked 

Currents”, below. 

4 Tether Voltage with Tracked Currents 

The Tether Voltage example presented in Section 3 above illustrates the use of resistive coupling 

to explore the effects of resistance on a simple tethered system model. That example uses orbit-

limited current collection models that do not adequately represent the actual current collection in 

a dense low-Earth-orbit plasma environment to make it as simple as possible. 

In this example, the same system is modeled, using sheath limited ram ion collection on the 

lower body and magnetically limited and sheath limited electron collection on the upper body. 

Due to the large separation between the two bodies, this requires the construction of disjoint 

computational grids about the upper and lower bodies. 

The system parameters, the coordinate system, and the geometry are the same as in the Tether 

Voltage example (Section 3). 

4.1 Creating the grids about the upper and lower objects 

In order to create separate computational grids about the upper body and lower body, the two 

components need to be in separate files.  

4.1.1 Create upper body 

Create a Box that is zoned 3 × 3 × 3, has dimension 1 m × 1 m × 1 m, and has all surfaces 

aluminum and conductor 1. Save to a file named case . 

4.1.2 Create tether stub and lower body 

On the File Menu, select “New Object”. Create a Boom that is zoned 1 × 1 × 2 and has 

dimension 0.1 m × 0.1 m × 1 m. Make the surfaces Graphite and conductor 2. Select a node on 

the +Z end of the boom and using the “Node Relative Move” menu item on the Component 

menu move it to a position of Z = -1.1 m and centered in X and Y. 

For the lower body, create a Cylinder with 12 circumferential zones, 8 zones along its height, a 

height of 8 meters, and a diameter of 2 meters. Make the surfaces Gold and conductor 3. Select 

an edge parallel to the cylinder axis and, using the “Align Edge” menu item on the Component 

menu make that edge parallel to the Y axis. Viewing the cylinder from the –X direction, select 

the node at the center of the cylinder and move it to position (-1, 0, 0). Save the object containing 

the tether stub and the lower body to a file .  
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4.1.3 Computational grids 

Next define a grid structure about each object in the usual way. At present, it is necessary for 

both outer grids to have the same mesh spacing. Using different primary grid spacings causes 

potentials to be both wrongly calculated and displayed.  

Open GridTool by selecting it from the Windows Start Menu. Import the upper object using 

“Import Object” on the File menu. From the Grid menu select “New Primary Grid”. On the 

Primary Grid dialog box that appears, set the grid dimension to 48×48×48 with a mesh size of 

0.13 m. Click the “OK” button. Save the grid as and exit GridTool. 

Reopen GridTool and import the lower object. Set the grid dimension to 68×128×68 with a mesh 

size of 0.13 m. Save the grid as  and exit GridTool. 

The two grid files must be combined using the CombineGrids Java application. The jar for this 

application is included in the  folder in the Nascap-2k installation, and can be run by 

double-clicking CombineGrids.jar. Figure 15 shows the user interface. Enter the full paths of 

the first and second grid files created and saved above. Enter the offset vector as  

“0.0, 0.0, -200.0” to set the center of the upper grid as 200 m anti-Earthward from the center of 

the lower grid. Enter the full path of output grid file with name “ ”. Click the 

“Combine” button to write out the combined grid file.  

 

Figure 15. CombineGrids user interface. 

4.2 Set up the project 

Create a new project named “Tether” in a directory containing the new grid file 

( ), possibly the two component objects, and no other “GriddedTether” files.  

Launch the Nascap-2k user interface and click the “Create New Project” button. Uncheck 

“Create New Folder” and click “Set Location” to place the project in the folder containing 

. Assign the prefix “GriddedTether” to the project. Click “OK.” 

On the File menu select “Load Object…”. Navigate to the primary object definition file (in this 

case ), select it, and click “Open.” The second object ( ) is added 

later through the script. The “Grid Status” should show the grid already loaded. 

On the Problem tab, specify the calculation as “LEO or Plume” Environment and “Surface 

Charging” with “Tracked Particle Currents”. “Potentials in Space or Detector Analysis”, 

“Analytic Space Charge”, and “Surface Currents” are automatically checked.  

Set the Environment tab to have the parameters shown in Figure 11 for the Tether example. 

Set the Applied Potentials tab to have the parameters shown in Figure 12 for the Tether 

example. 
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On the Charging tab, specify charging for 2×10-4 seconds using 10 timesteps with a minimum of 

2×10-5 seconds. The script to be built performs charging one step at a time while looping through 

other commands. The timestep was chosen with hindsight to work well for the parameters of this 

problem. 

On the Space Potentials tab, set the charge density model to be “Non-linear”. Set the species for 

the Geometric Wake to be Oxygen. Set the “Target Average (RMS) Error (V)” to be 10-2 V. 

On the Particles tab, the Surface Currents subtab should be displayed. Select “Sheath” with a 

“Potential Value” of 1 V. Check both particle species checkboxes. Click the “Advanced” button 

to bring up the Advanced Particle Parameters dialog box.” On the “Tracking limits (m)” panel, 

uncheck the “Track throughout grid” checkbox. The X, Y, and Z bounds are in meters relative to 

the center of the primary grid, i.e., the lower body. Enter -999.0 for the X and Y lower values, 

and -9999.0 for the Z lower value. Enter 999.0 for the three upper values. (This is needed 

because the input files are written prior to running the script, before the initial steps of the script 

define the grid.) Later we will check the Tracker output file to see that these values are processed 

correctly. Click “OK” to exit the dialog. 

The script used to create the combined object (as it appears on the Script tab) is shown in Figure 

16. This can be built by adding commands to the script within the Nascap-2k interface. 

Alternatively, it may be written to a file and loaded by selecting “Load Script” on the File menu. 

Note that the (x,y,z) coordinates in the Append Object command correspond to the “Object 

Center Offset” displayed by CombineGrids and are not necessarily the same as the grid offset. 

The argument of the Append Object command is the full pathname to the second object, 

.  

To create the script, on the Script tab, click “Build Script” to build the default script. As the 

script needs to be edited, switch to the Edit Script subtab. Highlight the Read Object command 

and add an Append Object command immediately following. Expand the Append Object 

command. In the FileName textbox enter the full path to . The x, y, and z values 

are the offsets entered previously in the CombineGrids interface (Figure 15). Enter -200.0 for the 

Z offset. 

By default, the surface potentials are initialized to the values shown on the Applied Potentials 

tab. An additional Charge Surfaces command is needed to apply the v×B potentials. Highlight 

the Embed Object in Grid command and insert a Charge Surfaces command after it. Highlight 

the ChargeSurfaces command just inserted and insert the second level commands “SetBField”, 

“SetVelocity”, “SetCircuit”, and “SetVXBPotentials”. Expand the Charge Surfaces command 

and check that the magnetic field and velocity correspond to what was set on the Environment 

tab. Expand the “SetVXBPotentials second level command and note there is a value to be set. 

This value is the maximum potential on the object. Set this value to 6.0 volts, which was the 

result of the earlier “Tether” example. The script, with the items of interest expanded, should be 

similar to that shown in Figure 16. 

Open the Charge Surfaces command that appears just above the Loop command. The 

“SetBField”, “SetVelocity”, and “SetCircuit” second level commands are not necessary as these 

parameters have already been set. Remove the “SetInitialConductorPotentials” second level 

command as the conductor potentials were already set by the “SetVXBPotentials” within the 

previous Charge Surfaces command. (See Figure 17.) 
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Open the Charge Surfaces command that appears within the Loop command. As all of the 

parameters have already been set, only the second level command “DoOneTimeStep”, which 

instructs the code to take one charging timestep, is needed. (See Figure 17.)  

Click the “Run Script” button to execute the script. 

 

Figure 16. Script tab after adding Append Object and Charge Surfaces to the script. 
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Figure 17. Script tab showing the Charge Surfaces commands immediately preceding the Loop 

command and within the Loop command. 

4.3 Examine results with all components connected. 

4.3.1 Potentials and currents 

On the Results tab, select “Potential”. To see the v × B potentials we must look at the surfaces 

rather than the conductors, which are not localized. In the top panel, add two additional “Surface 

Element Groups” for a total of three. In the “Conductor” column specify the conductors 1, 2, and 

3. Check all three “Plot” checkboxes and click the “Plot” button.  

On the Text subtab, note that the upper body approaches steady state at an average potential of 

8.9 V, the tether stub at -35.9V, and the lower body at -36.2 V, as is shown in the left panel of 

Figure 18. The “Charging Current” can be plotted as a function of the potential as shown in the 

right panel of Figure 18. The “Charging Current” is current used by the Charge Surfaces 

module. Note that for charging using tracked currents, the Charge Surfaces module does not 

update the charging current at the end of the timestep. Therefore the charging current is that 

calculated by tracking in the potentials of the previous timestep. Thus the second (repeated) 

current value should be assigned to the first potential value, with an offset of one step continuing 

down the line. The areas used to convert the current density to current are 6 m2, 0.42 m2, and 

55.6932 m2 for the upper body, the tether stub, and the low body respectively. (These values 

appear in the command window and log file each time the Surface Element Groups are plotted.) 

Figure 18 shows that the upper, electron-collecting body collects -88 µA (compared with about 

1 mA in the earlier calculation). Fitting the upper body current shows that it is proportional to the 

0.291 power of potential, somewhat slower than the 0.5 power predicted by magnetic limiting, 

and much slower than the linear dependence of the orbit-limited treatment used in the earlier 
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calculation. The lower, ion-collecting body collects 90 µA, with very little variation with 

potential. From the fit to the total current, the true steady-state upper body potential is predicted 

to be 9.4 V. The fitting parameters may differ by a fraction of a percent from those shown here. 

The currents are displayed with limited precision, and variations in the exact location of the 

tether stub can lead to small changes in the potential solution. 

   

Figure 18. Left Panel: Time behavior of the upper (left axis) and lower body (right axis) 

potentials. Right Panel: Potential dependence of the upper body current (which is negative) and 

the total current for the shorted case. 

4.3.2 Particle tracker output file 

It is well worth noting some of the information in the Particle Tracker output file. Open the last 

such file, “GriddedTether_tracker_trajE_10_out.txt”, with a text editor that shows line numbers. 

1. Up through line 30 the input parameters are defined. More current and complete 

definitions can be found in the Nascap-2k User’s Manual. 

2. Lines 31-50 review some of the grid and problem parameters. Note on line 49 the Z 

component of CXYZOffset. This is the location of the center of the object relative to the 

center of the primary grid (containing the lower body). Since we placed the upper body at 

-200 m in Z, the value of -99.475 seems about right. 

3. Lines 51 through 84 echo the received input. Further processing of the input goes through 

line 118. Note that lines 72-74 contain the numbers we entered into the Advanced 

Particle Parameters dialog box in Section 4.2, with the caveat that no grid information 

would be available at the time the input files are generated. These numbers appear 

translated to grid units on lines 106-107. The value of -1527.5 is the offset (in grid units 

of 13 cm) of the –Z face of the upper grid from the –Z face of the lower, primary grid. 

4. Lines 120 through 139 summarize the existing set of electron macroparticles, which in 

this case consists of electron macroparticles newly generated at the sheath surface. The 

“Weight” of these particles is the total current in amperes, which in this case is 291 µA.  

5. Lines 140-147 give the results of tracking those macroparticles. The 88 µA cited as 

“dead” represent the current to the upper body. The remaining 203 µA were magnetically 

shielded from the upper body, and eventually left the grid. 
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6. Lines 170-192 give a history of the particle tracking results, including both ions and 

electrons. The “Collected” current decreases with time, approaching current balance. The 

“Lost” current, representing electrons that have left the grid, increases with time, 

representing the growth of the sheath with increasing potential while most of the sheath 

current is magnetically shielded from the object. 

4.3.3 Electron trajectories 

Nascap-2k can be used to visualize the trajectories of sheath- and magnetically limited electrons. 

Go to the Results3D tab, and set the view to be from the Y axis, i.e., along the magnetic field. As 

nothing is visible, click the “Zoom Out” button  about fifteen times until the upper and lower 

bodies appear on the screen. As the upper body appears on the bottom, click one of the circle-

arrow buttons  six times to move the Z-axis from pointing up to pointing down. Now use the 

up and down buttons  and the zoom in button  to center the upper body and zoom in 

on it. Plot potential contours in the Y=0 plane, setting the minimum of the potential scale to 0.0. 

The image should be similar that shown in Figure 19. Note that the potential contours are made 

short-range by the plasma screening and are compressed on the ram side and elongated on the 

wake side.  

Now add electron trajectories to the image. Click the “Specify Trajectories…” button. In the 

Particle Visualization dialog box, request electrons on the “Contour” with potential 1 V (the 

value used for the sheath boundary) in the Y=0 plane (the contour plane plotted). For the plotting 

limits and the tracking limits, make sure the lower Z limit is a large negative number. In the 

“Weed” line, specify that every tenth particle is to be plotted. Click the “OK” button. The image 

should be similar to the left panel of Figure 21, showing that the generated electrons E×B drift 

around the 1 V contour and are magnetically insulated from the Upper Body. 

Use the rotate button  to rotate the view so that the X-axis points out of the screen and the 

Y-axis points to the right. Hide the Y=0 cutplane and plot a new cutplane for X=0, again setting 

the minimum potential to 0.0 V. Generate visualization particles along the X=0, 1 V contour. As 

on the right panel of Figure 21, the particles move back and forth along the magnetic field 

direction (Y-direction). Only a few reach the upper body. 

4.3.4 Ion trajectories 

Viewing the system from the Y-axis with Z pointing down, zoom out to find the lower body, 

center it, and zoom in on it. Plot potentials in the Y=0 plane to obtain an image similar to the left 

panel of Figure 22. Click “Specify Trajectories…” to bring up the Particle Visualization dialog 

box. Set it to “Contour” with potential of 1 V in the Y=0.5 m plane. (The particle generation 

contour plane location is chosen so that the trajectories will appear in front of the potential 

contour plot.) Make sure the “Oxygen” species is checked. Set the “Weed” parameter to 3. Click 

the “OK” button. The image should be similar to the right panel of Figure 22. 

Most of the ions enter from the right, traveling leftward with the ram ion velocity plus a smaller 

thermal component. Those generated with a vertical location within about 2.5 m of the cylinder 

axis impact the lower body; those generated further out are deflected by the potentials and leave 

the computational space. On the wake side of the contour, low-weight thermal ions are launched 

and strike the lower body. To see the incident ion current density on the lower body, hide the 

trajectories and contour plane and select “Tracked Current” for the spacecraft display. Results 
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are shown in Figure 23. Use the Results” tab to determine the mean ion current to the ram side 

of the lower body. It is 2.3 µA m-2, while that to the wake side is 0.84 µA m-2. These numbers 

compare with the raw ram ion current (Nev) of 1.2 µA m-2. 

 

Figure 19. Potential contours around the upper body. 
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Figure 20. Particle visualization dialog box used to generate Figure 21 (left panel). 

  

Figure 21. Particle trajectories of electron macroparticles generated along Y=0 contour (left 

panel) and along X=0 contour (right panel). 
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Figure 22. Sheath potentials (left panel) and ion trajectories (right panel) near the lower body. 

 

Figure 23. Incident ion current density on wake side (left), and ram side (right) of the lower 

body. 

4.4 Examine results with resistive coupling 

Next, perform the same simulation with the lower body resistively coupled to the tether stub 

rather than shorted to it. The easiest way to do this is to copy the input files, along with the 

project file, into a new directory, make some minor alterations, and run the new problem from 

scratch. 

Create a new directory, and copy into it the files: GriddedTether.grd, , 

, and . 
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Open the project file with Nascap-2k. Leave the problem type and environment as is. On the 

Applied Potentials tab, in the top panel, change conductor 3 (lower body) from Biased to 

Floating. In the center panel, add a resistance of 1×105 Ω between conductors 3 and 2. On the 

Charging tab, increase the “Number of Timesteps” to 15, with a corresponding duration increase 

to 0.3 ms. 

On the Script tab, note that the “Script out of Date” message is showing. This is because the 

number of iterations has been changed from 10 to 15, and this parameter is not automatically 

updated in the script for low-Earth-orbit (dense plasma) charging simulations. The existing script 

can be edited or a new default script can be built. As the default script would also need to be 

edited, the following instructions take the first approach.  

Switch to the Edit Script subtab, where there are three Charge Surfaces commands. In the first 

Charge Surfaces command (following Embed Object In Grid), note that the “SetCircuit” 

second level command now contains one “ConductorBias” specification and one “Conductance” 

specification corresponding to the changes made on the Applied Potentials tab. In the second 

Charge Surfaces command (preceding Loop), the “SetCircuit” second level command has not 

been updated. Nascap-2k automatically updates the parameters associated with only the first 

instance of each command. This is to avoid overwriting any special settings the user may have 

added. Here the “SetCircuit” second level command needs to be updated. To do this, delete the 

command (using the “Delete Item” button) and replace it (using the “>>Add Command>>” 

button) with a new “SetCircuit” second level command. Repeat for the third Charge Surfaces 

command (within the Loop command). In the Loop command, set the number of iterations to be 

14. (One additional iteration is performed outside the Loop.) Finally, click the “Run Script” 

button to execute the script. 

As above, plot the potentials of the three bodies over time and the upper body current and total 

current as a function of upper body potential. Results are shown in Figure 24. Comparing with 

the shorted case (Figure 18): 

1. The lower body is about 8 V positive relative to the tether stub, rather than being at 

nearly the same potential. 

2. The upper body collects a maximum of about 80 µA, compared with 88 µA in the shorted 

case. 

3. Extrapolating the total current gives a steady-state upper body potential of 6.85 V, 

compared with 9.4 V for the shorted case. 

4. The voltage dependence of the upper body current is again well under the expected 0.5 

power. 

Uncheck the three “Surface Element Groups” and instead check the three “Conductor” rows and 

plot their potential. These values are referenced to the same point at the center of the object. If 

you take differences of these potentials, the v×B contributions cancel, and you obtain the values 

that would be measured by conventional voltmeters. Figure 25 compares the potential difference 

between the lower body and tether stub with the IR voltage inferred from the upper body 

collected current. After some initial transient behavior these two values match at about 8 V. 
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Figure 24. For the resistive (100 kΩ) case, potentials of the three components versus time (left 

panel), and upper body and total currents versus upper body potential (right panel). 

 

Figure 25. Measured lower body to stub potential difference (blue curve), compared with value 

inferred from upper body current flowing through 100 kΩ resistor (orange curve). 

4.5 Examine results with smaller upper body 

If the upper body is smaller, it will need to go to higher potential in order to collect enough 

electrons to balance the ram ion current to the lower body. To do this copy the basic input files, 

along with the project file, into a new directory, make some minor alterations, and run the new 

problem from scratch. 

Create a new directory, and copy into it the files  , 

, and . 

Use Object Toolkit (by selecting it from the Windows Start Menu) to edit .  

Highlight the box and click “Edit Component” on the Edit menu. Change “X Size”, “Y Size”, 

and Z Size” from 1.0 m to 0.7 m to create an object with about half the previous cross-section 

area. Save the object and exit ObjectToolkit. 

Open the project file with Nascap-2k. On the Applied Potentials tab, make sure conductors 2 

and 3 are biased to conductor 1 by 0 volts. On the Charging tab, set the parameters for 15 
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timesteps with a minimum of 20 microseconds and a duration of 0.3 milliseconds. The Space 

Potentials tab should specify non-linear charge density, geometric wake initialization with 

Oxygen, and a Target RMS error of 10-3 V. 

On the Script tab, note that because the number of iterations was changed, the “Script out of 

Date” message is showing. In the following instructions, this message is ignored as the existing 

script is edited. On Edit Script subtab, make sure the Append Object command specifies the 

correct path to the newly-saved  file. There are three Charge Surfaces 

commands. Make sure their “SetCircuit” second level commands correspond to the 

specifications on the Applied Potentials tab. If not, delete the outdated versions and replace 

them with new ones. Make sure the Loop command specifies 14 iterations starting at 1. 

Results are shown in Figure 26. The upper body steady-state potential is estimated at 15.5 V, 

collecting current of 81 µA (remembering that the area was reduced to 2.94 m2). As expected, 

the upper body potential is higher but the current is about the same, as it must balance the ram 

ion current collected by the lower body which is only weakly voltage-dependent. The collected 

current goes as the 0.6 power of the voltage, (compared with the 0.3 power seen in the earlier 

cases), suggesting that for the smaller object at higher potential, magnetic limiting is more 

important than sheath limiting. 

   

Figure 26. For the case of smaller upper body, individual body potentials vs. time (left panel), 

and upper body and total currents vs. upper body potential (right panel). 

4.6 Discussion 

In this example, Nascap-2k was used to simulate an electrodynamic tether, including sheath and 

magnetic limiting. In the “Tether” example in Section 3, this simulation was performed using 

analytic currents, with the caveat that the analytic currents were far too high and did not have 

correct dependencies on the problem parameters. Even in that case, the dependence of upper 

body potential on resistance could be simulated. 
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Here we did three variations of the same simulation including the physics of sheath- and 

magnetically-limited current collection by constructing a computational grid, solving for space 

potentials, and tracking particles. The parameters used in these simulations are as follows: 

1. Tether Length of 200 m; 

2. Magnetic field of 3×10-5 Tesla; 

3. Ram ion collecting lower body; 

4. Plasma with density 109 m-3 and temperature 1 eV. 

The differences between the cases, along with the results, are shown in Table 1. The interested 

reader is encouraged to additional simulations to map out dependencies. 

Table 1. Parameters and results for the three calculations presented here. 

Upper Body 1 m cube 1 m cube 0.7 m cube 

Resistance 0 100 kΩ 0 

Upper Body Potential 9.4 V 6.85 V 15.5 V 

Upper Body Current 88 µA 80 µA 81 µA 

Power Law 0.3 0.3 0.6 

 

This advanced example uses several Nascap-2k capabilities, including disjoint grids, managing a 

script, interpreting the Particle Tracker output file, and plotting particle trajectories for 

visualization. 
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